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CHAPTER

Introducing Excel

IN THIS CHAPTER
Understanding what Excel is 

used for

What’s new for Excel 2010

Learning the parts of Excel’s 
window

Introducing the Ribbon user 
interface, shortcut menus, 
and dialog boxes

Navigating Excel worksheets

Introducing Excel with a quick 
hands-on session

This chapter serves as an introductory overview of Excel 2010. If 
you’re already familiar with a previous version of Excel, reading this 
chapter is still a good idea. You’ll find that Excel 2010 is very similar 

to Excel 2007. However, both Excel 2007 and Excel 2010 are different from 
every previous version — very different.

What Is Excel Good For?
Excel, as you probably know, is the world’s most widely used spreadsheet 
program, and is part of the Microsoft Office suite. Other spreadsheet pro-
grams are available, but Excel is by far the most popular and has become the 
world standard.

Much of the appeal of Excel is due to the fact that it’s so versatile. Excel’s 
forte, of course, is performing numerical calculations, but Excel is also very 
useful for non-numeric applications. Here are just a few of the uses for Excel:

l Number crunching: Create budgets, analyze survey results, and 
perform just about any type of financial analysis you can think of.

l Creating charts: Create a wide variety of highly customizable charts.

l Organizing lists: Use the row-and-column layout to store lists 
efficiently.

l Accessing other data: Import data from a wide variety of sources.

l Creating graphical dashboards: Summarize a large amount of 
business information in a concise format.
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l Creating graphics and diagrams: Use Shapes and the new SmartArt to create 
professional-looking diagrams.

l Automating complex tasks: Perform a tedious task with a single mouse click with 
Excel’s macro capabilities.

What’s New in Excel 2010?
When a new version of Microsoft Office is released, sometimes Excel gets lots of new features. And 
sometimes it gets very few new features. In the case of Office 2010, Excel got very few new fea-
tures. Here’s a quick summary of what’s new in Excel 2010, relative to Excel 2007:

l 64-bit version: If your hardware (and Windows version) supports it, you can install 
the 64-bit version, which lets you create larger workbooks. Most people do not 
require the 64-bit version, and using it might cause some add-ins to not function.

l Sparkline charts: Create small in-cell charts to summarize a range of data graphically. See 
Chapter 21.

l Slicers: A new way to filter and display data in pivot tables, by clicking buttons. See 
Chapter 35.

l New pivot table formatting options: You have more control over the appearance of pivot 
table reports. See Chapter 35.

l Office button changes: The big round Office button in Excel 2007 has been replaced by 
a File button/tab, displayed to the left of the tabs. Clicking it displays a screen that lets you 
perform various operations on your workbook. This view essentially replaces the tradi-
tional File and Print menus — plus quite a bit more.

l Conditional formatting enhancements: Data bar conditional formatting can display in a 
solid color, and the bars provide a more accurate display. See Chapter 20.

l Function enhancements: Some Excel worksheet financial and statistical functions have 
been improved in terms of numerical accuracy.

l Image editing enhancements: You have much more control over graphic images inserted 
into a workbook, including the ability to remove nonessential parts from the background 
of an image.

l Screen capture tool: You can easily capture a window from a different program and then 
insert the image on a worksheet.

l Paste preview: When you copy a range, the Paste command displays various options with 
a live preview so you can see how the paste operation will look.

05_474877-ch01.indd   405_474877-ch01.indd   4 3/29/10   11:35 PM3/29/10   11:35 PM



Chapter 1: Introducing Excel

5

l Ribbon customization: You can customize the Ribbon by adding new tabs and groups.

l Equation editor: Create and display (noncalculating) mathematical equations and embed 
them on a worksheet. See Chapter 22.

l Faster: Microsoft made some improvements to the calculation engine, and files load a bit 
faster.

l New security features: Workbooks downloaded from the Internet or from e-mail attach-
ments are opened in Protected View mode. Workbooks can be designated as “trusted,” 
and don’t need to reside in special trusted folders.

l Solver: Excel 2010 includes a new version of the Solver add-in, which is useful for solving 
some complex problems.

l Enhancements to VBA: Operations that used to require old XLM macros can now be per-
formed directly using VBA macro commands. In addition, macro recording now works for 
operations such as chart shape formatting.

Understanding Workbooks 
and Worksheets
The work you do in Excel is performed in a workbook file, which appears in its own window. You 
can have as many workbooks open as you need. By default, Excel 2010 workbooks use an .xlsx 
file extension.

Each workbook comprises one or more worksheets, and each worksheet is made up of individual 
cells. Each cell contains a value, a formula, or text. A worksheet also has an invisible draw layer, 
which holds charts, images, and diagrams. Each worksheet in a workbook is accessible by clicking 
the tab at the bottom of the workbook window. In addition, workbooks can store chart sheets. A 
chart sheet displays a single chart and is also accessible by clicking a tab.

Newcomers to Excel are often intimidated by all the different elements that appear within Excel’s 
window. After you become familiar with the various parts, it all starts to make sense.

Figure 1.1 shows you the more important bits and pieces of Excel. As you look at the figure, refer 
to Table 1.1 for a brief explanation of the items shown in the figure.
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 FIGURE 1.1

The Excel screen has many useful elements that you will use often.
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 TABLE 1.1

Parts of the Excel Screen That You Need to Know
Name Description

Active cell indicator This dark outline indicates the currently active cell (one of the 
17,179,869,184 cells on each worksheet).

Application Close button Clicking this button closes Excel.

Application Minimize button Clicking this button minimizes the Excel window.

Column letters Letters range from A to XFD — one for each of the 16,384 columns in the 
worksheet. You can click a column heading to select an entire column of 
cells, or drag a column border to change its width.

File button Click this button to open Back Stage view, which contains many options 
for working with your document (including printing), and setting Excel 
options.

Formula bar When you enter information or formulas into a cell, it appears in this line.

Help button Clicking this button displays the Excel Help system window.

Horizontal scrollbar Use this tool to scroll the sheet horizontally.

Macro recorder indicator Click to start recording a VBA macro. The icon changes while your actions 
are being recorded. Click again to stop recording.

Minimize Ribbon button Clicking this button hides the Ribbon, giving you a bit more space 
onscreen. When you click a tab, the Ribbon reappears.

Name box This field displays the active cell address or the name of the selected cell, 
range, or object.

Page View buttons Change the way the worksheet is displayed by clicking one of these buttons.

Quick Access toolbar This customizable toolbar holds commonly used commands. The Quick 
Access toolbar is always visible, regardless of which tab is selected.

Ribbon This is the main location for Excel commands. Clicking an item in the tab 
list changes the Ribbon that displays.

Row numbers Numbers range from 1 to 1,048,576 — one for each row in the worksheet. 
You can click a row number to select an entire row of cells.

Sheet tabs Each of these notebook-like tabs represents a different sheet in the work-
book. A workbook can have any number of sheets, and each sheet has its 
name displayed in a sheet tab.

Insert Sheet button By default, each new workbook that you create contains three sheets. Add 
a new sheet by clicking the Insert Worksheet button (which is displayed 
after the last sheet tab).

Sheet tab scroll buttons Use these buttons to scroll the sheet tabs to display tabs that aren’t visible.

continued
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 TABLE 1.1 (continued)

Name Description

Status bar This bar displays various messages as well as the status of the Num Lock, 
Caps Lock, and Scroll Lock keys on your keyboard. It also shows summary 
information about the range of cells that is selected. Right-click the status 
bar to change the information that’s displayed.

Tab list Use these commands to display a different Ribbon, similar to a menu.

Title bar This displays the name of the program and the name of the current work-
book, and also holds some control buttons that you can use to modify the 
window.

Vertical scrollbar Use this to scroll the sheet vertically.

Window Close button Clicking this button closes the active workbook window.

Window Maximize/Restore 
button

Clicking this button increases the workbook window’s size to fill Excel’s 
complete workspace. If the window is already maximized, clicking this but-
ton “unmaximizes” Excel’s window so that it no longer fills the entire screen.

Window Minimize button Clicking this button minimizes the workbook window, and it displays as 
an icon.

Zoom control Use this scroller to zoom your worksheet in and out.

Moving around a Worksheet
This section describes various ways to navigate through the cells in a worksheet. Every worksheet 
consists of rows (numbered 1 through 1,048,576) and columns (labeled A through XFD). After 
column Z comes column AA, which is followed by AB, AC, and so on. After column AZ comes BA, 
BB, and so on. After column ZZ is AAA, AAB, and so on.

The intersection of a row and a column is a single cell. At any given time, one cell is the active cell. 
You can identify the active cell by its darker border, as shown in Figure 1.2. Its address (its column 
letter and row number) appears in the Name box. Depending on the technique that you use to 
navigate through a workbook, you may or may not change the active cell when you navigate.

Notice that the row and column headings of the active cell appear in different colors to make it 
easier to identify the row and column of the active cell.
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 FIGURE 1.2

The active cell is the cell with the dark border — in this case, cell C8.

Navigating with your keyboard
Not surprisingly, you can use the standard navigational keys on your keyboard to move around a 
worksheet. These keys work just as you’d expect: The down arrow moves the active cell down one 
row, the right arrow moves it one column to the right, and so on. PgUp and PgDn move the active 
cell up or down one full window. (The actual number of rows moved depends on the number of 
rows displayed in the window.)

Tip
You can use the keyboard to scroll through the worksheet without changing the active cell by turning on 
Scroll Lock, which is useful if you need to view another area of your worksheet and then quickly return to your 
original location. Just press Scroll Lock and use the navigation keys to scroll through the worksheet. When you 
want to return to the original position (the active cell), press Ctrl+Backspace. Then, press Scroll Lock again to 
turn it off. When Scroll Lock is turned on, Excel displays Scroll Lock in the status bar at the bottom of the 
window. n

The Num Lock key on your keyboard controls how the keys on the numeric keypad behave. When 
Num Lock is on, the keys on your numeric keypad generate numbers. Many keyboards have a sep-
arate set of navigation (arrow) keys located to the left of the numeric keypad. The state of the Num 
Lock key doesn’t affect these keys.

Table 1.2 summarizes all the worksheet movement keys available in Excel.
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 TABLE 1.2

Excel Worksheet Movement Keys
Key Action

Up arrow (↑) Moves the active cell up one row.

Down arrow (↓) Moves the active cell down one row.

Left arrow (←) or Shift+Tab Moves the active cell one column to the left.

Right arrow (→) or Tab Moves the active cell one column to the right.

PgUp Moves the active cell up one screen.

PgDn Moves the active cell down one screen.

Alt+PgDn Moves the active cell right one screen.

Alt+PgUp Moves the active cell left one screen.

Ctrl+Backspace Scrolls the screen so that the active cell is visible.

↑* Scrolls the screen up one row (active cell does not change).

↓* Scrolls the screen down one row (active cell does not change).

←* Scrolls the screen left one column (active cell does not change).

→* Scrolls the screen right one column (active cell does not change).

* With Scroll Lock on

Navigating with your mouse
To change the active cell by using the mouse, click another cell; it becomes the active cell. If the 
cell that you want to activate isn’t visible in the workbook window, you can use the scrollbars to 
scroll the window in any direction. To scroll one cell, click either of the arrows on the scrollbar. 
To scroll by a complete screen, click either side of the scrollbar’s scroll box. You also can drag the 
scroll box for faster scrolling.

Tip
If your mouse has a wheel, you can use the mouse wheel to scroll vertically. Also, if you click the wheel and 
move the mouse in any direction, the worksheet scrolls automatically in that direction. The more you move the 
mouse, the faster the scrolling. n

Press Ctrl while you use the mouse wheel to zoom the worksheet. If you prefer to use the mouse 
wheel to zoom the worksheet without pressing Ctrl, choose File  ➪  Options and select the 
Advanced section. Place a check mark next to the Zoom on Roll with Intellimouse check box.

Using the scrollbars or scrolling with your mouse doesn’t change the active cell. It simply scrolls 
the worksheet. To change the active cell, you must click a new cell after scrolling.
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Introducing the Ribbon
The most dramatic change introduced in Office 2007 was the new user interface. In most Office 
2007 applications, traditional menus and toolbars were replaced with the Ribbon. In Office 2010, 
all applications use the Ribbon interface. In addition, the Ribbon can be customized in Office 2010 
(see Chapter 23).

Ribbon tabs
The commands available in the Ribbon vary, depending upon which tab is selected. The Ribbon is 
arranged into groups of related commands. Here’s a quick overview of Excel’s tabs.

l Home: You’ll probably spend most of your time with the Home tab selected. This 
tab contains the basic Clipboard commands, formatting commands, style commands, 
commands to insert and delete rows or columns, plus an assortment of worksheet 
editing commands.

l Insert: Select this tab when you need to insert something in a worksheet — a table, 
a diagram, a chart, a symbol, and so on.

l Page Layout: This tab contains commands that affect the overall appearance of your 
worksheet, including some settings that deal with printing.

l Formulas: Use this tab to insert a formula, name a cell or a range, access the formula 
auditing tools, or control how Excel performs calculations.

l Data: Excel’s data-related commands are on this tab.

l Review: This tab contains tools to check spelling, translate words, add comments, or 
protect sheets.

l View: The View tab contains commands that control various aspects of how a sheet is 
viewed. Some commands on this tab are also available in the status bar.

l Developer: This tab isn’t visible by default. It contains commands that are useful for 
programmers. To display the Developer tab, choose File  ➪  Options and then select 
Customize Ribbon. In the Customize the Ribbon section on the right, place a check 
mark next to Developer and then click OK.

l Add-Ins: This tab is visible only if you loaded an older workbook or add-in that custom-
izes the menu or toolbars. Because menus and toolbars are no longer available in Excel 
2010, these user interface customizations appear on the Add-Ins tab.

Note
Although the File button shares space with the tabs, it’s not actually a tab. Clicking the File button displays the 
new Back Stage view, where you perform actions with your documents. n
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The appearance of the commands on the Ribbon varies, depending on the width of Excel window. 
When the window is too narrow to display everything, the commands adapt; some of them might 
seem to be missing, but the commands are still available. Figure 1.3 shows the Home tab of the 
Ribbon with all controls fully visible. Figure 1.4 shows the Ribbon when Excel’s window is made 
more narrow. Notice that some of the descriptive text is gone, but the icons remain. Figure 1.5 
shows the extreme case when the window is made very narrow. Some groups display a single icon. 
However, if you click the icon, all the group commands are available to you.

 FIGURE 1.3

The Home tab of the Ribbon.

 FIGURE 1.4

The Home tab when Excel’s window is made narrower.

 FIGURE 1.5

The Home tab when Excel’s window is made very narrow.

Tip
If you would like to hide the Ribbon to increase your worksheet view, just double-click any tab. The Ribbon 
goes away, and you can see about five additional rows of your worksheet. When you need to use the Ribbon 
again, just click a tab, and it comes back temporarily. To keep the Ribbon turned on, double-click a tab. You 
can also press Ctrl+F1 to toggle the Ribbon display on and off. The Minimize the Ribbon button (to the left of 
the Help button) provides yet another way to toggle the Ribbon. n
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Contextual tabs
In addition to the standard tabs, Excel 2010 also includes contextual tabs. Whenever an object 
(such as a chart, a table, or a SmartArt diagram) is selected, specific tools for working with that 
object are made available in the Ribbon.

Figure 1.6 shows the contextual tab that appears when a chart is selected. In this case, it has three 
contextual tabs: Design, Layout, and Format. Notice that the contextual tabs contain a description 
(Chart Tools) in Excel’s title bar. When contextual tabs appear, you can, of course, continue to use 
all the other tabs.

 FIGURE 1.6

When you select an object, contextual tabs contain tools for working with that object.

Types of commands on the Ribbon
When you hover your mouse pointer over a Ribbon command, you’ll see a pop-up box that con-
tains the command’s name as well as a brief description. For the most part, the commands in the 
Ribbon work just as you would expect them to. You do encounter several different styles of com-
mands on the Ribbon.
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l Simple buttons: Click the button, and it does its thing. An example of a simple button is 
the Increase Font Size button in the Font group of the Home tab. Some buttons perform 
the action immediately; others display a dialog box so that you can enter additional infor-
mation. Button controls may or may not be accompanied by a descriptive label.

l Toggle buttons: A toggle button is clickable and also conveys some type of information 
by displaying two different colors. An example is the Bold button in the Font group of the 
Home tab. If the active cell isn’t bold, the Bold button displays in its normal color. If the 
active cell is already bold, though, the Bold button displays a different background color. 
If you click this button, it toggles the Bold attribute for the selection.

l Simple drop-downs: If the Ribbon command has a small down arrow, the command is a 
drop-down. Click it, and additional commands appear below it. An example of a simple 
drop-down is the Conditional Formatting command in the Styles group of the Home tab. 
When you click this control, you see several options related to conditional formatting.

l Split buttons: A split button control combines a one-click button with a drop-down. If you 
click the button part, the command is executed. If you click the drop-down part (a down 
arrow), you choose from a list of related commands. You can identify a split button com-
mand because it displays in two colors when you hover the mouse over it. An example of 
a split button is the Merge & Center command in the Alignment group of the Home tab 
(see Figure 1.7). Clicking the left part of this control merges and centers text in the 
selected cells. If you click the arrow part of the control (on the right), you get a list of 
commands related to merging cells.

 FIGURE 1.7

The Merge & Center command is a split button control.

l Check boxes: A check box control turns something on or off. An example is the Gridlines 
control in the Show group of the View tab. When the Gridlines check box is checked, the 
sheet displays gridlines. When the control isn’t checked, the sheet gridlines don’t appear.

l Spinners: Excel’s Ribbon has only one spinner control: the Scale To Fit group of the Page 
Layout tab. Click the top part of the spinner to increase the value; click the bottom part of 
the spinner to decrease the value.
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Some of the Ribbon groups contain a small icon on the right side, known as a dialog box launcher. 
For example, if you examine the Home  ➪  Alignment group, you see this icon (see Figure 1.8). 
Click it, and Excel displays the Format Cells dialog box, with the Alignment tab preselected. The 
dialog launchers generally provide options that aren’t available in the Ribbon.

 FIGURE 1.8

Some Ribbon groups contain a small icon on the right side, known as a dialog box launcher.

Accessing the Ribbon by using your keyboard
At first glance, you may think that the Ribbon is completely mouse-centric. After all, none of the 
commands have the traditional underline letter to indicate the Alt+keystrokes. But in fact, the 
Ribbon is very keyboard friendly. The trick is to press the Alt key to display the pop-up keytips. 
Each Ribbon control has a letter (or series of letters) that you type to issue the command.

Tip
You don’t need to hold down the Alt key while you type keytip letters. n

Figure 1.9 shows how the Home tab looks after I press the Alt key to display the keytips. If you 
press one of the keytips, the screen then displays more keytips. For example, to use the keyboard 
to align the cell contents to the left, press Alt, followed by H (for Home) and then AL (for Align 
Left). Nobody will memorize all these keys, but if you’re a keyboard fan (like me), it takes just a 
few times before you memorize the keystrokes required for commands that you use frequently.

After you press Alt, you can also use the left- and right-arrow keys to scroll through the tabs. 
When you reach the proper tab, press the down arrow to enter the Ribbon. Then use left and right 
arrow keys to scroll through the Ribbon commands. When you reach the command you need, 
press Enter to execute it. This method isn’t as efficient as using the keytips, but it’s a quick way to 
take a look at the commands available.
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 FIGURE 1.9

Pressing Alt displays the keytips.

Using Shortcut Menus
In addition to the Ribbon, Excel features many shortcut menus, which you access by right-clicking 
just about anything within Excel. Shortcut menus don’t contain every relevant command, just 
those that are most commonly used for whatever is selected.

As an example, Figure 1.10 shows the shortcut menu that appears when you right-click a cell. The 
shortcut menu appears at the mouse-pointer position, which makes selecting a command fast and 
efficient. The shortcut menu that appears depends on what you’re doing at the time. For example, 
if you’re working with a chart, the shortcut menu contains commands that are pertinent to the 
selected chart element.

 FIGURE 1.10

Click the right mouse button to display a shortcut menu of commands you’re most likely to use.
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The box above the shortcut menu — the Mini toolbar — contains commonly used tools from the 
Home tab. The Mini toolbar was designed to reduce the distance your mouse has to travel around 
the screen. Just right-click, and common formatting tools are within an inch from your mouse 
pointer. The Mini toolbar is particularly useful when a tab other than Home is displayed. If you use 
a tool on the Mini toolbar, the toolbar remains displayed in case you want to perform other format-
ting on the selection.

Customizing Your Quick Access Toolbar
The Ribbon is fairly efficient, but many users prefer to have some commands available at all 
times — without having to click a tab. The solution is to customize your Quick Access toolbar. 
Typically, the Quick Access toolbar appears on the left side of the title bar, above the Ribbon. 
Alternatively, you can display the Quick Access toolbar below the Ribbon; just right-click the 
Quick Access toolbar and choose Show Quick Access Toolbar below the Ribbon.

Displaying the Quick Access Toolbar below the Ribbon provides a bit more room for icons, but it 
also means that you see one less row of your worksheet.

By default, the Quick Access toolbar contains three tools: Save, Undo, and Repeat. You can 
customize the Quick Access toolbar by adding other commands that you use often. To add a 
command from the Ribbon to your Quick Access toolbar, right-click the command and choose 
Add to Quick Access Toolbar. If you click the down arrow to the right of the Quick Access toolbar, 
you see a drop-down menu with some additional commands that you might want to place in your 
Quick Access toolbar.

If you find the Mini toolbar annoying, you can search all day and not find an option to turn it off. The 
General tab of the Excel Options dialog box has an option labeled Show Mini Toolbar on Selection, but 
this option applies to selecting characters while editing a cell. The only way to turn off the Mini toolbar 
when you right-click is to execute a VBA macro:

Sub ZapMiniToolbar()
    Application.ShowMenuFloaties = True
End Sub

The statement might seem wrong, but it’s actually correct. Setting that property to True turns off the 
Mini toolbar. It’s a bug that appeared in Excel 2007 and was not fixed in Excel 2010 because correcting 
it would cause many macros to fail. (See Part VI for more information about VBA macros.)

Mini Toolbar Be Gone
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Excel has commands that aren’t available on the Ribbon. In most cases, the only way to access these 
commands is to add them to your Quick Access toolbar. Right-click the Quick Access toolbar and 
choose Customize the Quick Access Toolbar. You see the dialog box shown in Figure 1.11. This sec-
tion of the Excel Options dialog box is your one-stop shop for Quick Access toolbar customization.

 FIGURE 1.11

Add new icons to your Quick Access toolbar by using the Quick Access Toolbar section of the Excel 
Options dialog box.

Cross-Reference
See Chapter 23 for more information about customizing your Quick Access toolbar. n

Caution
You can’t reverse every action, however. Generally, anything that you do using the File button can’t be 
undone. For example, if you save a file and realize that you’ve overwritten a good copy with a bad one, Undo 
can’t save the day. You’re just out of luck. n

The Repeat button, also on the Quick Access toolbar, performs the opposite of the Undo button: 
Repeat reissues commands that have been undone. If nothing has been undone, then you can use 
the Repeat button (or Ctrl+Y) to repeat the last command that you performed. For example, if you 
applied a particular style to a cell (by choosing Home  ➪  Styles  ➪  Cell Styles), you can activate 
another cell and press Ctrl+Y to repeat the command.
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Working with Dialog Boxes
Many Excel commands display a dialog box, which is simply a way of getting more information 
from you. For example, if you choose Review  ➪  Changes  ➪  Protect Sheet, Excel can’t carry out 
the command until you tell it what parts of the sheet you want to protect. Therefore, it displays the 
Protect Sheet dialog box, shown in Figure 1.12.

 FIGURE 1.12

Excel uses a dialog box to get additional information about a command.

Excel dialog boxes vary in how they work. You’ll find two types of dialog boxes:

l Typical dialog box: A modal dialog box takes the focus away from the spreadsheet. When 
this type of dialog box is displayed, you can’t do anything in the worksheet until you dis-
miss the dialog box. Clicking OK performs the specified actions, and clicking Cancel (or 
pressing Esc) closes the dialog box without taking any action. Most Excel dialog boxes are 
this type.

You can reverse almost every action in Excel by using the Undo command, located on the Quick 
Access toolbar. Click Undo (or press Ctrl+Z) after issuing a command in error, and it’s as if you never 
issued the command. You can reverse the effects of the past 100 actions that you performed by execut-
ing Undo more than once.

If you click the arrow on the right side of the Undo button, you see a list of the actions that you can 
reverse. Click an item in that list to undo that action and all the subsequent actions you performed.

Changing Your Mind
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l Stay-on-top dialog box: A modeless dialog box works in a manner similar to a toolbar. 
When a modeless dialog box is displayed, you can continue working in Excel, and the 
dialog box remains open. Changes made in a modeless dialog box take effect immediately. 
For example, if you’re applying formatting to a chart, changes you make in the Format 
dialog box appear in the chart as soon as you make them. A modeless dialog box has a 
Close button but no OK button.

Most people find working with dialog boxes to be quite straightforward and natural. If you’ve used 
other programs, you’ll feel right at home. You can manipulate the controls either with your mouse 
or directly from the keyboard.

Navigating dialog boxes
Navigating dialog boxes is generally very easy — you simply click the control you want to activate.

Although dialog boxes were designed with mouse users in mind, you can also use the keyboard. 
Every dialog box control has text associated with it, and this text always has one underlined letter 
(a hot key or an accelerator key). You can access the control from the keyboard by pressing Alt and 
then the underlined letter. You also can press Tab to cycle through all the controls on a dialog box. 
Pressing Shift+Tab cycles through the controls in reverse order.

Tip
When a control is selected, it appears with a dotted outline. You can use the spacebar to activate a selected 
control. n

Using tabbed dialog boxes
Many Excel dialog boxes are “tabbed” dialog boxes: That is, they include notebook-like tabs, each 
of which is associated with a different panel.

When you click a tab, the dialog box changes to display a new panel containing a new set of con-
trols. The Format Cells dialog box, shown in Figure 1.13, is a good example. It has six tabs, which 
makes it functionally equivalent to six different dialog boxes.

Tabbed dialog boxes are quite convenient because you can make several changes in a single dialog 
box. After you make all your setting changes, click OK or press Enter.

Tip
To select a tab by using the keyboard, press Ctrl+PgUp or Ctrl+PgDn, or simply press the first letter of the tab 
that you want to activate. n

Excel 2007 introduced a new style of modeless tabbed dialog box in which the tabs are on the left, 
rather than across the top. Excel 2010 also uses this style. Figure 1.14 shows the Format Shape 
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dialog box, which is modeless tabbed. To select a tab using the keyboard, press the up- or down-
arrow key and then Tab to access the controls.

 FIGURE 1.13

Use the dialog box tabs to select different functional areas in the dialog box.

 FIGURE 1.14

A tabbed dialog box with tabs on the left.
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Using the Task Pane
The final user interface element that I discuss is the task pane. The task pane appears automatically 
in response to several commands. For example, to insert a clip art image, choose Insert  ➪  
Illustrations  ➪  Clip Art. Excel responds by displaying the Clip Art task pane, shown in Figure 
1.15. The task pane is similar to a dialog box except that you can keep it visible as long as you like. 
There’s no OK button. When you’re finished using a task pane, click the Close button in the 
upper-right corner.

By default, the task pane is docked on the right side of the Excel window, but you can move it any-
where you like by clicking its title bar and dragging. Excel remembers the last position, so the next 
time you use that task pane, it will be right where you left it.

 FIGURE 1.15

The Clip Art task pane.

Creating Your First Excel Worksheet
This section presents an introductory hands-on session with Excel. If you haven’t used Excel, you 
may want to follow along on your computer to get a feel for how this software works.

In this example, you create a simple monthly sales projection table along with a chart.

Getting started on your worksheet
Start Excel and make sure that you have an empty workbook displayed. To create a new, blank 
workbook, press Ctrl+N (the shortcut key for File  ➪  New  ➪  Blank Workbook  ➪  Create).
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The sales projection will consist of two columns of information. Column A will contain the month 
names, and column B will store the projected sales numbers. You start by entering some descrip-
tive titles into the worksheet. Here’s how to begin:

 1. Move the cell pointer to cell A1 (the upper-left cell in the worksheet) by using the 
navigation (arrow) keys. The Name box displays the cell’s address.

 2. Enter Month into cell A1 and press Enter. Depending on your setup, Excel either 
moves the cell pointer to a different cell, or the pointer remains in cell A1.

 3. Move the cell pointer to B1, type Projected Sales, and press Enter.

  The text extends beyond the cell width, but don’t worry about that for now.

Filling in the month names
In this step, you enter the month names in column A.

 1. Move the cell pointer to A2 and type Jan (an abbreviation for January). At this point, 
you can enter the other month name abbreviations manually, but you can let Excel do 
some of the work by taking advantage of the AutoFill feature.

 2. Make sure that cell A2 is selected. Notice that the active cell is displayed with a heavy 
outline. At the bottom-right corner of the outline, you’ll see a small square known as the 
fill handle. Move your mouse pointer over the fill handle, click, and drag down until 
you’ve highlighted from A2 down to A13.

 3. Release the mouse button, and Excel automatically fills in the month names.

Your worksheet should resemble the one shown in Figure 1.16.

Entering the sales data
Next, you provide the sales projection numbers in column B. Assume that January’s sales are pro-
jected to be $50,000, and that sales will increase by 3.5 percent in each subsequent month.

 1. Move the cell pointer to B2 and type 50000, the projected sales for January. You 
could type a dollar sign and comma to make the number more legible, but you do the 
number formatting a bit later.

 2. To enter a formula to calculate the projected sales for February, move to cell B3 and 
enter the following: =B2*103.5%. When you press Enter, the cell displays 51750. The 
formula returns the contents of cell B2, multiplied by 103.5%. In other words, February 
sales are projected to be 3.5% greater than January sales.

 3. The projected sales for subsequent months use a similar formula. But rather than 
retype the formula for each cell in column B, once again take advantage of the AutoFill 
feature. Make sure that cell B3 is selected. Click the cell’s fill handle, drag down to cell 
B13, and release the mouse button.
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 FIGURE 1.16

Your worksheet, after entering the column headings and month names.

At this point, your worksheet should resemble the one shown in Figure 1.17. Keep in mind that 
except for cell B2, the values in column B are calculated with formulas. To demonstrate, try changing 
the projected sales value for the initial month, January (in cell B2). You’ll find that the formulas recal-
culate and return different values. These formulas all depend on the initial value in cell B2, though.

 FIGURE 1.17

Your worksheet, after creating the formulas.

Formatting the numbers
The values in the worksheet are difficult to read because they aren’t formatted. In this step, you 
apply a number format to make the numbers easier to read and more consistent in appearance:

 1. Select the numbers by clicking cell B2 and dragging down to cell B13.

05_474877-ch01.indd   2405_474877-ch01.indd   24 3/29/10   11:35 PM3/29/10   11:35 PM



Chapter 1: Introducing Excel

25

Tip
Don’t drag the fill handle this time, though, because you’re selecting cells, not filling a range. n

 2. Choose Home  ➪  Number, click the drop-down Number Format control (it initially 
displays General), and select Currency from the list. The numbers now display with a 
currency symbol and two decimal places. Much better!

Making your worksheet look a bit fancier
At this point, you have a functional worksheet, but it could use some help in the appearance 
department. Converting this range to an “official” (and attractive) Excel table is a snap:

 1. Move to any cell within the range.

 2. Choose Insert  ➪  Tables  ➪  Table. Excel displays its Create Table dialog box to make 
sure that it guessed the range properly.

 3. Click OK to close the Create Table dialog box. Excel applies its default table format-
ting and also displays its Table Tools  ➪  Design contextual tab. Your worksheet should 
look like Figure 1.18.

 4. If you don’t like the default table style, just select another one from the Table 
Tools  ➪  Design  ➪  Table Styles group. Notice that you can get a preview of different 
table styles by moving your mouse over the Ribbon. When you find one you like, click it, 
and style will be applied to your table.

 FIGURE 1.18

Your worksheet, after converting the range to a table.

Summing the values
The worksheet displays the monthly projected sales, but what about the total projected sales for 
the year? Because this range is a table, it’s simple.
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 1. Activate any cell in the table

 2. Choose Table Tools  ➪  Design  ➪  Table Style Options  ➪  Total Row. Excel automati-
cally adds a new row to the bottom of your table, including a formula that calculated the 
total of the Projected Sales column.

 3. If you’d prefer to see a different summary formula (for example, average), click cell 
B14 and choose a different summary formula from the drop-down list.

Creating a chart
How about a chart that shows the projected sales for each month?

 1. Activate any cell in the table.

 2. Choose Insert  ➪  Charts  ➪  Column and then select one of the 2-D column chart 
types. Excel inserts the chart in the center of your screen.

Tip
To move the chart to another location, click its border and drag it. To change the appearance and style of the 
chart, use the commands on the Chart Tools contextual tab. n

Figure 1.19 shows the worksheet with a column chart. Your chart may look different, depending 
on the chart layout or style you selected.

On the CD
This workbook is available on the companion CD-ROM. The filename is table and chart.xlsx. 

 FIGURE 1.19

The table and chart.
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Printing your worksheet
Printing your worksheet is very easy (assuming that you have a printer attached and that it works 
properly).

 1. Make sure that the chart isn’t selected. If a chart is selected, it will print on a page by 
itself. To deselect the chart, just press Esc or click any cell.

 2. To make use of Excel’s handy page layout view, click the Page Layout View button 
on the right side of the status bar. Excel then displays the worksheet page by page so 
that you can easily see how your printed output will look. Figure 1.20 shows the work-
sheet zoomed out to show a complete page. In Page Layout view, you can tell immedi-
ately whether the chart is too wide to fit on one page. If the chart is too wide, click and 
drag a corner to resize it. Or, you can just move the chart below the table of numbers.

 FIGURE 1.20

Viewing the worksheet in Page Layout mode.
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 3. When you’re ready to print, choose File  ➪  Print.

  At this point, you can change some print settings. For example, you can choose to print 
in landscape rather than portrait orientation. Make the change, and you see the result in 
the preview window. When you’re satisfied, click the Print button in the upper-left cor-
ner. The page is printed, and you’re returned to your workbook.

Saving your workbook
Until now, everything that you’ve done has occurred in your computer’s memory. If the power 
should fail, all may be lost — unless Excel’s AutoRecover feature happened to kick in. It’s time to 
save your work to a file on your hard drive.

 1. Click the Save button on the Quick Access toolbar. (This button looks like an old-
fashioned floppy disk, popular in the previous century.) Because the workbook hasn’t 
been saved yet and still has its default name, Excel responds with the Save As dialog box.

 2. In the box labeled File Name, enter a name (such as Monthly Sales Projection), and 
then click Save or press Enter. Excel saves the workbook as a file. The workbook 
remains open so that you can work with it some more.

Note
By default, Excel saves a backup copy of your work automatically every ten minutes. To adjust the 
AutoRecover setting (or turn if off), choose File  ➪  Options, and click the Save tab of the Excel Options 
dialog box. However, you should never rely on Excel’s AutoRecover feature. Saving your work frequently 
is a good idea. n

If you’ve followed along, you may have realized that creating this workbook was not at all difficult. 
But, of course, you’ve barely scratched the surface. The remainder of this book covers these tasks 
(and many, many more) in much greater detail.
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